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Trademarks 
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Überblick 

Allgemeines 

Lpv Creator erzeugt Lpv Dateien, die mit dem Lpv Player abgespielt werden.  
Das Lpv Dateiformat ähnelt anderen Multimediaformaten wie z.B. AVI oder MPEG.  
Ein spezielles Komprimierungsverfahren ermöglicht jedoch eine qualitativ hochwertige Aufzeichnung 
von Lasershows bei kleinster Dateigröße, wie sie mit anderen Formaten nicht möglich ist. 
Zum Abspielen ohne den Lpv Player oder zur Weiterverarbeitung (z. B. Herstellen von Demo-
Videos) kann eine Lpv Datei auch in das AVI Format gewandelt werden. 
 
Die Software zum Abspielen der aufgezeichneten Lasershows, der sog. Lpv Player, kann kostenlos 
von der LaserAnimation Homepage heruntergeladen werden: 
 

https://laseranimation.com/downloads 
 
 
 
Über diese Bedienungsanleitung 

Vor der Installation von Lpv Creator sollten Sie das erste Kapitel  "Installation" sorgfältig lesen und 
die dort beschriebenen Schritte der Reihe nach ausführen.  
 
Einen Überblick über die Erstellung einer Lpv Datei gibt Ihnen das zweite Kapitel  "Lpv Aufzeich-
nung – Die Erste". Hier wird in wenigen Schritten die Erstellung einer Lpv Datei anhand der mitgelie-
ferten Demoshow (LpvTrailer) gezeigt.  
 
Im dritten Kapitel  "Lpv Creator Referenz" werden alle Funktionen von Lpv Creator im Detail 
erläutert.  
 
Im Anhang finden Sie eine Übersicht zu den Tastenkombinationen von Lpv Creator. 

https://laseranimation.com/downloads
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Installation 

Schritt 1 – Vor der Installation 

Auf Ihrem PC sollte stets die aktuelle Version von LGRemote installiert sein. Auf Ihrem Lasergraph 
DSP sollte die aktuellste Systemsoftware (mindestens aber Version "2004/06/09" oder neuer) laufen.  
Aktuelle Versionen und Installationsdateien finden Sie im Kundenbereich der LaserAnimation Home-
page: 
 

https://laseranimation.com/downloads 
 
 
 
Schritt 2 – Installation von Lpv Creator 

Sollten Sie Lpv Creator auf CD-ROM erhalten haben, legen Sie diese in ihr CD-Laufwerk ein. Die 
Installation wird automatisch gestartet. Sollten Sie die Autorun-Funktion deaktiviert haben, müssen 
Sie ggf. die Datei Setup.exe von Hand ausführen.  
 
Bei der Installation der Download-Version, z.B. "LpvCreator--2022-05-10.exe", führen Sie bitte diese 
Datei zum Start der Installation aus.  
Bitte folgen Sie der Installation Schritt für Schritt und merken Sie sich das Verzeichnis, in dem Sie 
Lpv Creator installiert haben. Bei der Standardinstallation ist das "C:\Program Files\Lpv Creator". 
Dort finden Sie u.a. Beispiele und Dokumentationen. 
 

 

https://laseranimation.com/downloads
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Schritt 3 – Lasergraph DSP für Lpv Creator freischalten 

Die Lizenz für das Programm ist beim Mark 2 fest integriert, eine explizite Freischaltung ist daher 
nicht erforderlich! 
 
Lpv Creator benötigt zum Aufzeichnen und Konvertieren von Lpv Dateien sowie zur Erstellung von 
AVI Dateien eine gültige Lpv Creator–Lizenz auf Ihrem Lasergraph DSP. Sie können Lpv Creator 
auf mehreren PCs installieren, nutzen können Sie ihn jedoch immer nur auf einem PC. 
 
Sie können mehrere Lasergraph DSP mit dem Lpv Creator nutzen, allerdings muss wenigstens ein 
Lasergraph DSP über die Lpv Creator–Lizenz verfügen. 
 
Wichtig: 
Besitzen Sie mehrere Lasergraph DSP, empfiehlt es sich, die Lizenz auf dem Lasergraph DSP zu instal-
lieren, der Ihnen am häufigsten zur Verfügung steht, weil Sie ohne diesen keine Lpv Dateien erzeugen 
oder bearbeiten können. 
 
Starten Sie nun LGRemote und verbinden Sie auf Ihren gewünschten Lasergraph DSP. 
 
Geben Sie in der Kommandozeile "ApplyLicenseKey" (kurz: "ALK")  ohne Parameter ein. 
 

 
 
Es wird ein Schlüssel angezeigt, der so genannte "Request-Code": 
 

 
 
Diesen Code (hier: "1234567") senden Sie bitte an lpv@laseranimation.com. Sie erhalten dann per  
E-Mail einen Freischalt-Code. 
 
Nachdem Sie den Freischalt-Code erhalten haben, müssen Sie diesen im Lasergraph DSP eingeben, 
um die Lizenz für Lpv Creator zu installieren. Da dieser Code sehr lang sein kann (ca. 80 Zeichen), 
empfehlen wir den Code nicht einzutippen, sondern direkt mit Copy-and-Paste in den Lasergraph 
DSP zu übertragen. Markieren Sie den Code dazu in Ihrer E-Mail und drücken Sie dann <Strg+C>. 
Verbinden Sie mit LGRemote auf Ihren Lasergraph DSP. In der Kommandozeile geben Sie "ApplyLi-
censeKey " (kurz: "ALK ") ein und drücken dann <Strg+V>: 
 

 
 

mailto:lpv@laseranimation.com
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Nach Bestätigen durch "ok" (oder <Return>) sollten Sie vom Lasergraph DSP folgende Antwort er-
halten: 
 

 
 
Bitte beachten Sie, dass hinter "response = " eine andere Zeichenfolge stehen kann als in dem Bild 
oben. Ihr Lasergraph DSP ist jetzt für den Lpv Creator freigeschaltet.  
 
Sollten Sie als Antwort "invalid license key" erhalten, prüfen Sie bitte die Softwareversion Ihres La-
sergraph DSP. Es sollte die neueste Version, mindestens aber Version 2004/06/09 sein. 
 
 
Zusätzliche Schritte nach der Installation / Update 

Sollte nach einer Installation ein Neustart erforderlich sein, wird Ihnen Ihr System dies vorschlagen. 
Sollten Probleme beim ersten Start nach der Installation des Lpv Creators auftreten, starten Sie Ihren 
PC auch dann neu, wenn dies nicht verlangt wurde. In einigen Fällen kann das evtl. Probleme behe-
ben.  
Beim ersten Start von Lpv Creator kann es vorkommen, dass eine sogenannte Fog-Datei erzeugt 
wird. Dabei werden Daten für den verwendeten 3D-Nebel berechnet. Dies kann einige Minuten in 
Anspruch nehmen, passiert aber nur einmal. 
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Lpv Aufzeichnung - Die Erste! 

Die Aufzeichnung einer kleinen Demo-Lasershow soll Ihnen einen Überblick über die Arbeitsweise 
von Lpv Creator geben.  
 
Vorbereitung 

Im Installationsverzeichnis des Lpv Creators befindet sich das Unterverzeichnis "Lasergraph DSP". 
Dort finden Sie die Beispielshow "LpvTrailer.BOOT". Kopieren Sie diese in ein für Ihren Lasergraph 
DSP freigegebenes Verzeichnis.  
 

 
 
Laden Sie die Show dann in den Lasergraph DSP. Nach dem Laden muss sich der Lasergraph DSP im 
Hauptbildschirm befinden. Alles muss so vorbereitet sein, dass die Show mit "Play 0:00:00,00" gestar-
tet werden kann. Starten Sie die Show aber noch nicht, das wird Lpv Creator für Sie übernehmen. 
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Nachdem Sie den Lpv Creator gestartet haben (im Startmenü: "Programme  Lpv Creator  Lpv 
Creator" oder als Icon auf dem Desktop), wählen Sie Ihren Lasergraph DSP aus (Menü: "File  Select 
DSPs" oder drücken Sie <Strg+S>). Ein Doppelklick mit der linken Maustaste verbindet Ihren Laser-
graph DSP nun mit dem Lpv Creator (siehe Kapitel "Lasergraph DSP auswählen"). 
  

 
 
Wenn Sie jetzt auf Ihrem Lasergraph DSP das Testbild aktivieren, sollte dieses im Lpv Creator ange-
zeigt werden. 
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Im Lasergraph DSP können Sie nun die Super Preview – Parameter einstellen. Diese finden Sie unter 
"Advanced Parameters  Super Preview" (siehe Kapitel "Super Preview"). 
In dem Beispiel "LpvTrailer" ist allerdings schon alles richtig eingestellt. 
 

 
 
Das Testbild sollten Sie wieder deaktivieren, wenn Sie alle Einstellungen vorgenommen haben, da dies 
ja hier nicht aufgezeichnet werden soll.  
 
 
 
... Und Action! 

Sie können jetzt die Show aufzeichnen, indem Sie aus dem Menü "File  Record Lpv" (<Alt+R>) 
wählen. In einer Dialogbox können Sie nun die Lpv Datei angeben oder eine bereits vorhandene Da-
tei überschreiben. Sie sollten jetzt folgendes Dialogfenster sehen: 
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Der Lpv Creator wartet nun auf Showdaten vom Lasergraph DSP. Klicken Sie auf den Button "Auto", 
wird die Show automatisch gestartet und Film für Film aufgezeichnet.  
 
Das dauert für die kleine Beispielshow ca. 40 Sekunden. Weitere Erklärungen zu den Funktionen 
finden Sie im Kapitel "Aufzeichnung der Lpv Datei ". 
 
Ist das Ende der Show erreicht, wird die Aufzeichnung automatisch beendet und Sie werden durch 
eine Dialogbox informiert.  
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Lpv Konvertierung 

 
Da der Lpv Creator zunächst nur die Bilddaten aufzeichnet, müssen die Audiodaten nachträglich hin-
zugefügt werden.  
 
Der zweite Schritt, "Lpv Konvertierung", fügt die Audiodaten hinzu. Die Konvertierung können Sie 
aus dem Menü starten, "File  Convert Lpv" (<Alt+C>). Sie sehen nun folgendes Fenster: 
 

 
 
Die Qualität des aufgezeichneten Bildes können Sie mit Qua lity verändern. Der Wert 90 liefert eine 
sehr gute Qualität. Normalerweise sollten Sie es bei diesem Wert belassen, weil bei kleineren Wer-
ten die Qualität sichtbar schlechter wird. 
L im it Fps können sie einschalten, um die Anzahl der gespeicherten Bilder pro Sekunde zu begren-
zen. 20 fps (frames per second) reichen normalerweise aus, um eine flüssige Bewegung zu erhalten. 
Für den ersten Test können Sie erst mal alles lassen, wie Lpv Creator es vorschlägt. 
 
Um die Audiodatei hinzuzufügen, aktivieren Sie die Checkbox "Edit Audio" und wählen mit "Browse" 
die Audiodatei aus. Die zur Show LpvTrailer gehörende Audiodatei "LpvTrailer.wav" finden Sie im 
Installationsverzeichnis von Lpv Creator.  
 



Bedienungsanleitung Lpv Creator 2025/07/22 

 

 

LaserAnimation Sollinger GmbH    Crellestrasse. 19/20    D-10827 Berlin 
Phone  +49 (30) 780 963 00    Fax  +49 (30) 780 963 25 
Email  info@laseranimation.com    Internet  www.laseranimation.com 
 
Copyright © LaserAnimation Sollinger GmbH. All rights reserved. 

Seite 16 

 
 
Wählen Sie nun diese Datei aus und bestimmen Sie, in welcher Qualität die Audiodaten hinzugefügt 
und die Bilddaten konvertiert werden sollen.  
 
Mit der Voreinstellung (P reset) 5 wird der Ton in guter Qualität kodiert. Stereo Ton belegt dabei 
etwa 1 MByte pro Minute. Wenn eine kleine Dateigröße wichtiger ist als eine gute Qualität, wählen 
Sie P reset 3. Dann passen bereits 4 Minuten in ein MByte. 
 
Detaillierte Erklärungen der Parametern finden Sie im Kapitel "Konvertierung der Lpv Datei". 
 
Klicken Sie dann auf S ave, bestätigen Sie ggf. das Überschreiben der Version ohne Ton (diese wird ja 
nicht mehr benötigt). Die erste Lpv Datei ist nun fertig und wird direkt in Lpv Creator abgespielt. 
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AVI Export 

Für Präsentation und Archivierung ist das Lpv Dateiformat ideal geeignet. Sollten Ihre Kunden aber 
nicht über die Möglichkeit verfügen, den Lpv Player zu installieren (z.B. unter anderen Betriebssys-
temen), können Sie Lpv Dateien auch in das AVI Format umwandeln. 
 
Um folgendes Fenster zu öffnen, drücken Sie die Tasten <Alt+A> oder wählen Sie im Menü "File  
Save AVI".  
 

 
 
Um eine AVI-Datei zu erzeugen, die auf den meisten Systemen läuft, wählen Sie den "Cinepak 
Codec". Die Qualität sollten Sie auf 90 verringern, weil sonst die Datei extrem groß wird. 
Beim Audioformat sind Sie mit "PCM" auf der sicheren Seite. Natürlich können Sie auch andere 
Codecs wählen, sofern diese auf Ihrem System installiert sind. Beachten Sie aber, dass nicht alle 
Codecs auf allen Systemen zur Verfügung stehen. Stellen Sie sicher, dass Sie nur Codecs verwenden, 
die auch auf den Systemen installiert sind, auf denen die AVI Datei abgespielt oder bearbeitet werden 
soll. 
 
Klicken Sie dann auf S ave, um die Konvertierung zu starten. 
 
Weitere Informationen zum AVI-Export finden Sie im Kapitel "Erstellen einer AVI Datei". 
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Das Lpv Creator Menü 

Menü – File 

 
 
Open 

Öffnet eine oder mehrere Lpv Dateien. (<Strg+O>) 
 
Close 

Schließt die aktuell geöffnete Lpv Datei. (<Strg+W>) 
 
Close All 

Schließt alle geöffneten Lpv Dateien. (<Strg+Entf>) 
 
Select DSPs 

Öffnet das Dialogfenster zur Auswahl der Lasergraph DSP. (<Strg+S>) 
(siehe Kapitel "Lasergraph DSP auswählen") 
 
Record Lpv 

Öffnet das Dialogfenster zur Aufzeichnung einer Lasershow. (<Alt+R>) 
(siehe Kapitel "Aufzeichnung der Lpv Datei") 
 
Convert Lpv 

Öffnet das Dialogfenster zur Konvertierung von Lpv Dateien. (<Alt+C>) 
(siehe Kapitel "Konvertierung der Lpv Datei") 
 
Write AVI 

Öffnet das Dialogfenster zur Erstellung von AVI-Media-Dateien. (<Alt+A>) 
(siehe Kapitel "Erstellen einer AVI Datei") 
 
Exit 

Beendet Lpv Creator. (<Strg+Q>) 
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Menü – Edit 

 
 
Cut 

Schneidet ein eingefügtes Hintergrundbild aus und fügt dieses in die Zwischenablage ein. (<Strg+X>) 
 
Copy 

Kopiert das aktuelle Bild in die Zwischenablage. (<Strg+C>) 
 
Paste 

Fügt ein Bild aus der Zwischenablage als Hintergrundbild ein. (<Strg+V>) 
 
Properties 

Öffnet das Lpv Creator Eigenschaften-Fenster. (<P>) 
(siehe Kapitel "Lpv Creator Properties") 
 
Reset to File's Properties 

Zurücksetzen der Einstellungen auf die in der Lpv Datei abgespeicherten Werte. Wenn keine speziel-
len Werte in der Lpv Datei gespeichert sind, werden die Standardwerte benutzt. (<Strg+R>) 
 
Reset to Generic Defaults 

Zurücksetzen der Einstellungen auf die Standardwerte von Lpv Creator. Evtl. in der Lpv Datei vor-
handene Werte werden ignoriert. (<Strg+Alt+R>) 
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Menü – View 

 
 
Always On Top 

Lpv Creator wird immer im Vordergrund dargestellt. (<Strg+T>) 
 
Opacity  

Die Transparenz des Fensters lässt sich in 10% Schritten verändern. 
 
Anmerkung: 

• Die Einstellung funktioniert nur im Fenstermodus. 
Im Vollbildmodus gibt es keine Transparenz. 

 
Auflösungen 

Auswahl einer der vordefinierten oder einer frei wählbaren Auflösung für das Lpv Creator Fenster. 
(<F2> bis <F12>) 
 
Full Screen 

Wechselt zwischen Vollbild- und Fensterdarstellung. (<Alt+Return>) 
 
Caption/Frame 

Umschalten der Darstellung: 
Standard-Fenster  Fenster ohne Menü  Fenster ohne Rahmen  Standard-Fenster (<Strg+M>) 
 
Playback Control 

Ein- bzw. Ausschalten des Players am unteren Fensterrand. (<E>) 
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Infos 

Ein- bzw. Ausschalten der Zusatzinformationen. Ist die Ausgabe der Informationen eingeschaltet, 
werden verschiedene Informationen eingeblendet: 
Links oben im Bild wird der aktuelle Timecode eingeblendet. Links unten wird die Ausgabefrequenz 
des Bildes bei Ausgabe über einen Laserprojektor angezeigt (geschätzt). Rechts unten wird angezeigt, 
wie oft die Simulation am Bildschirm berechnet wird. (<I>) 
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Menü – Play 

 
 
Play / Pause 

Starten / Anhalten der aktuellen Lasershow. (<Leertaste>) 
 
Mute 

Ein- bzw. Ausschalten der Soundausgabe. (<M>) 
 
Next File 

Wechsel zur nächsten Lpv Datei. (<Bild ↓>) 
 
Previous File 

Wechsel zur vorherigen Lpv Datei. (<Bild ↑>) 
 
Beginning 

Player springt an den Anfang der aktuellen Lpv Datei. (<Pos1>) 
 
End 

Player springt an das Ende der aktuellen Lpv Datei. (<Ende>) 
 
Forward 

Vorspulen in der aktuellen Lpv Datei. (<→>) 
 
Backward 

Zurückspulen in der aktuellen Lpv Datei. (<←>) 
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Fast Forward 

Schnelles Vorspulen in der aktuellen Lpv Datei. (<Strg+→>) 
 
Fast Backward 

Schnelles Zurückspulen in der aktuellen Lpv Datei. (<Strg+←>) 
 
Next Frame 

Wechselt zum nächsten Bild der aktuellen Lpv Datei. (<Strg+Alt+→>) 
 
Previous Frame 

Wechselt zum vorherigen Bild der Lpv Datei. (<Strg+Alt+←>) 
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Menü – Special 

 
 
Visualization 

Öffnet einen Dialog über den man die Visualisierung der Laservorschau in einer Visualisierungs-
Software ein- oder ausschalten kann und über den man die Zuordnung der einzelnen Projektoren zu 
den virtuellen Lasern in der Visualisierung konfigurieren kann. 
Als Visualisierungs-Software unterstützt der Lpv Creator die Software "LightConverse", "Depence 
V:3D", "Capture", "Realizzer 3D" und "wysiwyg". 
 
 
Send NetTimecode 

Ein- bzw. Ausschalten der Ausgabe vom Net-Timecode über Netzwerk. 
Der Net-Timecode kann dazu verwendet werden, einen oder mehrere Lasergraph DSP zu einem Lpv 
zu synchronisieren. 
 
 
Sync to NetTimecode 

Sobald "Sync to NetTimecode" eingeschaltet ist, wird die Wiedergabe einer Lpv-Datei zum empfan-
genen Net-Timecode synchronisiert. 
 
Anmerkung: 

• Solange die Wiedergabe zu externem Net-Timecode synchronisiert wird, ist die Tonausgabe 
abgeschaltet. 
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Super Preview 

Überblick 

Um festzulegen, wie eine Lasershow am Bildschirm dargestellt wird (z.B. als Grafik- oder als Raum-
show), sollten Sie die Super Preview Parameter im Lasergraph DSP entsprechend einstellen. Sie fin-
den den Dialog unter "Advanced Parameters" im Hauptbildschirm des Lasergraph DSP. 
Für jeden Satz Ausgabeparameter gibt es auch einen Satz Parameter für die Super Preview. So kön-
nen Sie z.B. für Film 1 andere Werte einstellen (z.B. für eine Grafikausgabe) als für Film 2 (der z.B. 
Raumeffekte zeigt). 
Sie können zwar einige Parameter auch direkt in Lpv Creator einstellen, diese wirken aber immer auf 
alle Filme/DSPs gleichzeitig. Wir empfehlen, möglichst immer die Parameter am Lasergraph DSP ein-
zustellen und die Werte in Lpv Creator nur im Einzelfall zu verändern. Betrachten Sie die Werte in 
Lpv Creator als eine Möglichkeit, die Wiedergabe nachträglich anzupassen (nach Aufzeichnung einer 
Show). 
 
Hier ein Überblick über die Parameter, die Sie direkt im Lasergraph DSP einstellen können: 
 

 
 
 
Scanner 1 & Scanner 2 

Anzahl der benutzten Scanner, die eine Ausgabe erzeugen. Sind zwei Scanner eingestellt, geben diese 
ein identisches an der Y-Achse gespiegeltes Bild aus. 
 
Graphics 

Mit Aktivieren dieses Parameters wird das Laserbild als Grafik ausgegeben. Wird "Fog" abgeschaltet, 
entspricht das einer Grafik-Projektion auf eine Leinwand. 
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Zusammen mit "Fog" ergibt sich eher der Effekt einer Gaze, die zwischen dem Betrachtungspunkt 
und dem Scanner aufgespannt wurde. 
Mit "Intensity" stellen Sie die Helligkeit der Grafik ein. Höhere Werte bedeuten hellere Linien.  
Über "Size" haben Sie Einfluss auf die Größe des Bildes, dabei können Sie die X- und Y-Größe ge-
trennt oder durch Festhalten und Ziehen des "&"-Zeichens beide Werte gleichzeitig einstellen. 
Mit "Position" stellen Sie die Positionen des Bildes ein. Auch hier können Sie die X- und Y-Position 
getrennt oder mit "&" beide gleichzeitig einstellen.  
 
Fog 

Aktivieren Sie diesen Parameter, dann füllt sich der virtuelle Raum mit Nebel. Dieser zieht dann in 
Wolken durch Ihr Vorschaubild. Die "Intensity" stellt die Helligkeit (Intensität) des Nebels ein. Dabei 
können Sie den Wert von kaum sichtbarem Nebel (0.1) bis zu komplett überstrahlenden Flächen 
einstellen. Mit "Position" stellen Sie die Positionen der Scanner ein. X- und Y-Positionen können Sie 
entweder getrennt oder gemeinsam einstellen ("&"). 
 
Beam Detection 

Ist dieser Parameter aktiviert, führt das Super Preview eine automatische Beam Detection (Erken-
nung) durch. D.h. Punkte, die einen oder mehrere Repeats haben, werden als helle Linien dargestellt. 
Die Intensität der Linien legen Sie mit dem Parameter "Intensity" fest. Der Parameter "Repeat" be-
stimmt, ab welchen Repeatwerten eine Linie als "Beam" gezeichnet werden soll.  
 
Beam Table 

Durch Aktivieren dieses Parameters werden Strahlen aus dem Beam-Table simuliert. Zwei vordefi-
nierte Varianten stehen zur Auswahl: Ein Beam-Table für 8 und einer für 20 Positionen. 
Wie deutlich die Beams hervorgehoben werden, wird mit "Intensity" eingestellt. 
 
 
Scanner Rating 

Ermöglicht die Simulation unterschiedlicher Scanner-Typen. 
 
 
Reset 

Setzt alle Parameter auf die Standardwerte zurück. Alle Einstellungen gehen dabei unwiderruflich 
verloren. 
 
Copy 

Kopiert alle Parameterwerte in die Zwischenablage. Diese steht Ihnen bis zum Ausschalten / Neu-
start des Lasergraph DSP zur Verfügung.  
 
Paste 

Fügt die Parameterwerte der Zwischenablage in das aktuelle Super Preview Set ein. Alte Einstellun-
gen werden dabei unwiderruflich überschrieben. 
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Lpv Creator Properties 

Überblick 

In den Lpv Creator "Properties" haben Sie die Möglichkeit, die Darstellung der im Lasergraph DSP 
geladenen Show bzw. der aktuellen Lpv Datei anzupassen.  
Temporäre Veränderungen der Grafik- oder Beamausgabe legen Sie hier fest. Intensität und Art des 
Nebels, Feineinstellung für Ihre Grafikkarte und die Einbindung von Hintergrundbildern können Sie 
hier ebenfalls einstellen. 
 
Aus Lpv Creator rufen Sie die Properties entweder über das Menü "Edit  Properties" auf oder mit 
dem Tastaturkürzel <P>.  
 

 
 
Default, Laden & Speichern 

 
"Reset all Parameters to default (As defined by Lpv File)" 
Das erste Icon von links setzt alle Parameter auf die Werte, die in der Lpv Datei festgelegt wurden.  
 

 
"Reset all Parameters to default (Ignore Lpv Parameters)" 
Das zweite Icon von links setzt die Parameter auf die im Standardwerte von Lpv Creator zurück. 
Einstellungen, die in der Lpv Datei gespeichert wurden, werden dabei ignoriert. 
 

 
"Load Parameters from File" 
Öffnet die Dialogbox zum Öffnen der aktuellen Einstellungen. Diese können zwischen LGPreview, 
Lpv Player und Lpv Creator beliebig ausgetauscht werden.  
 

 
"Save current Parameters to File" 
Öffnet die Dialogbox zum Abspeichern der aktuellen Einstellungen. So können Sie eine Einstellung 
später wieder verwenden, ohne alle Werte mühsam neu einzustellen. Auch die Hintergrundbilder 
werden mit allen Einstellungen gespeichert. 
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Properties – Main 

 
 
 
Überblick 

Außer der "Line Width" entsprechen alle Werte hier den Einstellungen, die Sie auch im Lasergraph 
DSP (Super Preview) vornehmen können. Allerdings wirken diese Werte immer auf alle Kanäle. Wir 
empfehlen, die Lpv Creator Werte nur in besonderen Fällen zu verändern, z.B. wenn Sie nach der 
Aufzeichnung etwas verändern wollen. Normalerweise sollten Sie die Parameter im Lasergraph DSP 
richtig einstellen, weil das flexibler ist und für jeden Kanal eigene Werte definiert werden können. 
Benutzen Sie die Werte in Lpv Creator z.B., um einer Grafik-Show nachträglich etwas Nebel hinzufü-
gen: 
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Einige Checkboxen können 3 Zustände annehmen, Default, Aktiv, Inaktiv. Die Einstellungen der Pro-
perties beziehen sich auf die Parameter des Super Preview gleichen Namens. "Graphics" in Lpv Crea-
tor entspricht der Einstellung "Graphics" im Super Preview des Lasergraph DSP. 
Eingabefelder sind gelb markiert, wenn sich die aktuelle Einstellung vom Standardwert unterscheidet. 
So können Sie schnell einen Überblick bekommen, welche Werte Sie verändert haben. Mit <Strg+D> 
können Sie für jedes Feld einzeln den Standardwert wiederherstellen. 
 

 
Default. Der im Super Preview Ihres Lasergraph DSP eingestellte Wert wird hier verwendet. 
  

 
Active. Aktivieren der Einstellung. Die im Super Preview vorgenommene Einstellung wird ignoriert. 
 

 
Inactive. Deaktivieren der Einstellung. Die im Super Preview vorgenommene Einstellung wird igno-
riert. 
 
Einige Werte wirken zusätzlich zu der Einstellung, die Sie im Lasergraph DSP vorgenommen haben. 
 
 
Line Width 

Dieser Parameter ist nur am PC einstellbar. Der Wert gibt die Linienbreite der Grafiken in Pixel an. 
Der Standardwert 2.0 führt meist zur besten Qualität, bei Vollbilddarstellung in hoher Auflösung 
können evtl. etwas breitere Linien ein besseres Bild ergeben. Auch wenn später in AVI gewandelt 
und auf Video aufgezeichnet werden soll, ist es unter Umständen besser, etwas breitere Linien einzu-
stellen (2.5 bis 3.0). 
Leider unterstützen nicht alle Grafikkarten eine beliebige Einstellung der Linienbreite. 
 
Graphics 

Mit Aktivieren dieses Parameters wird das Laserbild als Grafik ausgegeben. Wird "Fog" abgeschaltet, 
entspricht das einer Grafik-Projektion auf eine Leinwand. 
Zusammen mit "Fog" ergibt sich eher der Effekt einer Gaze, die zwischen dem Betrachtungspunkt 
und dem Scanner aufgespannt wurde. 
Mit "Intensity" stellen Sie die Helligkeit der Grafik ein. Höhere Werte bedeuten hellere Linien.  
Über "Size" haben Sie Einfluss auf die Größe des Bildes, dabei können Sie die X- und Y-Größe ge-
trennt oder durch Festhalten und Ziehen des  -Zeichens beide Werte gleichzeitig einstellen. 
Mit "Position" stellen Sie die Positionen des Bildes ein. Auch hier können Sie die X- und Y-Position 
getrennt oder mit  beide gleichzeitig einstellen.  
 
Fog 

Durch Aktivieren dieses Parameters füllt sich der virtuelle Raum mit Nebel. Dieser zieht dann in 
Wolken durch Ihr Vorschaubild. Die "Intensity" stellt die Helligkeit (Intensität) des Nebels ein. Dabei 
können Sie den Wert von kaum sichtbarem Nebel (0.1) bis zu komplett überstrahlenden Flächen 
einstellen. Mit "Position" stellen Sie die Positionen der Scanner ein. X- und Y-Positionen können Sie 
entweder getrennt oder gemeinsam einstellen ( ). 
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Beam Detect 

Ist dieser Parameter aktiviert, führt das Super Preview eine automatische Beam Detection (Erken-
nung) durch. D.h. Punkte, die einen oder mehrere Repeats haben, werden als helle Linien dargestellt. 
Die Intensität der Linien legen Sie mit dem Parameter "Intensity" fest. Der Parameter "Repeat" be-
stimmt, ab welchen Repeatwerten eine Linie als "Beam" gezeichnet werden soll.  
 
Beam Table 

Durch Aktivieren dieses Parameters werden Strahlen aus dem Beam-Table simuliert. Zwei vordefi-
nierte Varianten stehen zur Auswahl: Ein Beam-Table für 8 und einer für 20 Positionen. 
Wie deutlich die Beams hervorgehoben werden, wird mit "Intensity" eingestellt. 
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Properties - Fog 

 
 
Überblick 

Hier nehmen Sie Einstellungen für Details des Nebels vor. Diese Einstellungen werden nur auf dem 
PC durchgeführt. Beachten Sie bitte, dass Sie für die optimale Grafikausgabe eine schnelle Grafikkarte 
mit OpenGL-Unterstützung benötigen.  
 
True 3D Fog 

Aktivierung von True 3D F og macht die Darstellung des Nebels noch realistischer. Allerdings wird 
das nicht von allen Grafikkarten unterstützt. Es kann im Einzelfall auch vorkommen, dass es zwar 
funktioniert aber sehr langsam berechnet wird. 
 
Structure 

Die Struktur des Nebels lässt sich von unstrukturiert (Haze, 0.0) bis zu einer klaren, abgegrenzten, 
strukturierten Darstellung (1.0) verändern. 
 
Clouds 

Verändert den Anzahl an Wolken von keine Wolken (0.0) bis hin zu vielen, deutlich abgegrenzten 
Wolken (1.0).  
 
Speed 

Die Geschwindigkeit, mit der die Wolken durch Ihren virtuellen Showroom fliegen, können Sie mit 
"Speed" einstellen. Dabei bedeutet der Wert 0, dass sich die Wolken nicht bewegen. 
 
Direction 

Bestimmen Sie hier die Richtung, in die Ihre virtuellen Wolken sich bewegen.  
 
Rotate 

Dieser Parameter lässt die Wolken um die Z-Achse rotieren.  
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Properties – OpenGL Setup 

 
 
Überblick 

In diesem Abschnitt haben Sie die Möglichkeit, OpenGL-Parameter einzustellen. Die Standard-
konfiguration bietet meist die beste Ausgabe. Im Einzelfall kann es aber sein, dass Sie die Darstellung 
verbessern oder beschleunigen können, indem Sie diese Parameter für Ihre Grafikkarte optimieren. 
Lpv Creator analysiert Ihre Konfiguration und versucht, die optimalen Einstellungen zu ermitteln. 
Diese werden als System Default bezeichnet. Falls Sie eine bessere Konfiguration finden, können Sie 
diese abspeichern, so dass Sie beim nächsten Start von Lpv Creator automatisch aktiviert wird. Das 
wird als Default bezeichnet. 
 
Force generic OpenGL driver 

Dieser Parameter aktiviert den Software-OpenGL-Treiber von Microsoft® Windows®. Verwenden 
Sie diesen nur, wenn Darstellungsfehler auftreten. In der Praxis ist dieser Treiber aber sehr langsam 
und es kann mehrere Sekunden dauern, bis ein Bild berechnet wird. 
 
Enhanced Line Drawing 

Bei Aktivierung dieses Parameters werden Linien in einem speziellen Mode gezeichnet. Bei einigen 
Grafikkarten wird dadurch die Darstellung verbessert. 
 
Beam Profile 

Linien werden an den Kanten nicht hart abgeschnitten sondern haben ein Profil. Das sieht etwas rea-
listischer aus. Funktioniert nur, wenn gleichzeitig Enhanced L ine Drawing aktiviert ist. 
 
Polygon Smoothing 

Wenn diese Option von der Grafikkarte unterstützt wird, sieht das Bild meist sauberer aus und so 
genannte "Treppen" werden vermieden. Diese Option verlangsamt normalerweise nicht die Darstel-
lung, wenn Sie von der Grafikkarte unterstützt wird. Sie ist deshalb dem "Global Scene anti-Aliasing", 
das Sie evtl. im Setup Ihrer Grafikkarte einstellen können, überlegen. Auch hier hängt es von der 
Grafikkarte ab, ob sich das Bild damit tatsächlich verbessert. 
 
True 3D Fog 

siehe Kapitel "Properties – Fog" (Parameter "True 3D Fog") 
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Load Defaults 

Abgespeicherte Standardwerte bzgl. des OpenGL-Setups werden geladen.  
 
Save As Defaults 

Die aktuelle OpenGL-Konfiguration wird als Standardkonfiguration gespeichert.  
 
Reset To System Default 

Die OpenGL-Konfiguration wird auf die vom Lpv Creator ermittelten Einstellungen zurückgesetzt.  



Bedienungsanleitung Lpv Creator 2025/07/22 

 

 

LaserAnimation Sollinger GmbH    Crellestrasse. 19/20    D-10827 Berlin 
Phone  +49 (30) 780 963 00    Fax  +49 (30) 780 963 25 
Email  info@laseranimation.com    Internet  www.laseranimation.com 
 
Copyright © LaserAnimation Sollinger GmbH. All rights reserved. 

Seite 34 

Properties – Background 

 
 
Überblick 

Sie können bis zu vier verschiedene Hintergrundbilder, Logos oder Wasserzeichen in ihre Vorschau 
integrieren. Als Formate werden JPEG- und PNG-Dateien (PNG = Portable Network Graphics) ak-
zeptiert.  
Eine weitere Möglichkeit, Bilder in Ihre Lpv Datei einzufügen, ist, das gewünschte Bild aus einer Bild-
bearbeitungssoftware mit <Strg+C> in die Zwischenablage zu kopieren und dieses dann in den Lpv 
Creator als Hintergrundbild oder Logo mit <Strg+V> einzufügen. Die Bilder werden dann aber un-
komprimiert als Bitmap-Grafiken (BMP-Dateien) in die Lpv Datei übernommen. Die Lpv Datei kann 
dadurch sehr groß werden. Es empfiehlt sich daher, Bitmap-Grafiken zunächst ins JPEG- oder PNG-
Format umzuwandeln um Platz zu sparen. 
 
Load 

Aktivieren Sie diese Checkbox, um das angegebene Hintergrundbild darzustellen. Durch Klick auf den 
Button "Load" öffnen Sie eine Auswahlbox, in der Sie eine Grafik auswählen können.  
 
Intensity 

Bestimmen Sie hier die Intensität / Helligkeit des Hintergrundbildes. Es ist oft sinnvoll, die Intensität 
von Hintergrundbildern oder Wasserzeichen etwas zu verringern, damit die Lasersimulation nicht 
überstrahlt wird. 
 
Size 

Die Größe legen Sie mit dem Parameter "Size" fest.  
 
Position 

Der Parameter "Position" bestimmt die Position des Hintergrundbildes. Normalerweise werden Hin-
tergrundbilder zur Mitte hin ausgerichtet. Bei +/-10.0 können Sie die Bilder aber auch an einen der 
Ränder "anheften". 
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Lasergraph DSP auswählen 

 
 
 
Überblick 

In diesem Fenster wählen Sie die Lasergraph DSPs aus, von denen Sie Shows aufzeichnen wollen. Sie 
können mehr als einen Lasergraph DSP auswählen, aber der erste muss eine gültige Lizenz für Lpv 
Creator tragen. 
 
Available Lasergraph DSPs 

Liste aller verfügbaren Lasergraph DSPs. 
 
Add 

Hinzufügen des markierten Lasergraph DSP aus der Liste "Available Lasergraph DSPs".  
 
Remove 

Löschen der markierten Lasergraph DSPs aus der Liste "Selected Lasergraph DSPs". 
 
Remember 

Lpv Creator speichert die ausgewählten Lasergraph DSPs und stellt die Verbindung beim Neustart 
automatisch wieder her.  
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Aufzeichnung der Lpv Datei 

Überblick 

Die Aufzeichnung ist immer der erste Schritt bei Erzeugung einer Lpv Datei. Bevor die Aufzeichnung 
beginnen kann, müssen Sie eine Zieldatei (Destination) wählen. Diese geben Sie entweder als Datei-
namen an oder wählen eine vorhandene Lpv Datei zum Überschreiben.  
Als Dateiname wird beim Öffnen des Aufzeichnungsfensters der Name der aktuell im Lasergraph 
DSP geladenen Show voreingestellt. 
 
Wählen Sie "Speichern", um zur Aufzeichnung zu gelangen. Das Aufzeichnungsfenster wird geöffnet 
und Lpv Creator ist bereit zur Aufzeichnung (ready to record). 
 
Sie haben die Möglichkeit, eine Show automatisiert oder manuell aufzuzeichnen. Es empfiehlt sich 
aber grundsätzlich, die Shows automatisch aufzuzeichnen, da dann alle Einstellungen vom Lpv Creator 
vorgenommen werden.  
 
Klicken Sie auf den Button "Auto", wird die automatische Aufzeichnung gestartet. Sollten Sie über 
einen Lasergraph DSP workstation mit mehreren DSP-Karten verfügen, wählt der Lpv Creator nun 
für die Aufzeichnung die schnellste Ausgabekarte aus. Shows mit mehreren Ausgaben, z.B. Grafik-
show auf Film1 und Raumshow auf Film2, werden Film für Film einzeln aufgezeichnet. Jeder Film wird 
dabei auf die vom Lpv Creator ausgewählte DSP-Karte gelegt. Somit haben Sie die Möglichkeit, selbst 
auf einem Lasergraph DSP compact Multi-Scannershows aufzuzeichnen.  
Bevor Sie eine automatische Aufzeichnung starten, muss der Lasergraph DSP im Root-Modus sein, 
und die geladene Show muss sich mit "Play 0:00:00,00" starten lassen. Der Timecode muss automa-
tisch im Script beendet werden, da der Lpv Creator sonst das Ende der Show nicht erkennt und 
weiter läuft. 
Wenn Sie später Sound hinzufügen wollen, müssen Sie beachten, dass die Audiospur immer bei 
Timecode 1:00:00,00 eingesetzt wird. Passen Sie ggf. das Timescript entsprechend an. 
 
Sollte es nicht möglich sein, den Automatik-Modus zu benutzen, z.B. wenn Sie Interaktive Shows 
oder Spiele aufzeichnen wollen, können Sie die Show auch selbst am Lasergraph DSP starten. Sie 
müssen dann die Aufzeichnung in Lpv Creator manuell beenden. Falls die Show eigentlich ohne Script 
läuft (Film wird über Run gestartet), empfehlen wir, ein einfaches Script zu benutzen, damit Sie den 
Timecode festlegen können. (Wenn eine Show mit Run gestartet wird, ist der Timecode aus Sicht 
von Lpv Creator undefiniert.) 
 
Wichtig: 
Während der automatischen Aufzeichnung wird die Laserausgabe deaktiviert. Sie sollten die Laser-
ausgabe auf dem Lasergraph DSP während einer Aufzeichnung aus Sicherheitsgründen auch nicht 
aktivieren, da die in der Show enthaltenen Filme, ob Raum- oder Grafikshow, auf einer DSP-Karte 
ausgegeben werden.  
Nach dem Beenden der automatischen Aufzeichnung wird der Zustand der Show auf den Originalzu-
stand, d.h. den Zustand vor der Aufzeichnung, zurückgesetzt.  
Während der Aufzeichnung empfiehlt es sich, die Ausgabe im Vorschaufenster abgeschaltet zu lassen, 
damit die Ausgabe nicht die Aufzeichnung stört, wodurch es zu Aussetzern kommen könnte.  
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Destination 

Name und Verzeichnis der Lpv Datei, in der die Lasershow aufgezeichnet wird.  
 
Timecode 

Aktueller Timecode der aufzuzeichnenden Show.  
 
Channels 

Anzahl der bisher aufgezeichneten Filme. 
 
Images 

Anzahl der bisher aufgezeichneten Bilder. 
 
Size 

Aktuelle Größe der Lpv Datei während der Aufzeichnung. Die Datei kann während der Aufzeichnung 
ziemlich groß werden, weil die Daten zunächst unkomprimiert gespeichert werden. Nach Beenden 
der Aufzeichnung wird die Dateigröße aber durch die eingebaute Kompression reduziert.  
 
Show output while recording 

Darstellung der Lasershow während der Aufzeichnung. Nur auf sehr schnellen Systemen sinnvoll, 
weil sonst evtl. die Aufzeichnung gestört wird. 
 
Stop 

Beendet die automatische oder manuelle Aufzeichnung einer Show. Der bisher aufgezeichnete Teil 
wird gespeichert.  
 
Auto 

Startet die automatische Aufzeichnung einer Show. Das funktioniert nur, wenn die Show bereits ge-
laden ist und der Lasergraph DSP sich im Hauptbildschirm befindet. Die Show muss sich mit "Play 
0:00:00,00" starten lassen. Wenn später Sound hinzugefügt werden soll, sollte die eigentliche Show zu 
1:00:00,00 synchronisiert sein. Passen Sie ggf. das Timescript entsprechend an (z.B. mit Retim e) 
Sehen Sie sich das Timescript im mitgelieferten Beispiel "LpvTrailer.BOOT" an! 
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Konvertierung der Lpv Datei 

Überblick 

Die Konvertierung einer Lpv Datei erfüllt unterschiedliche Aufgaben. Zum einen ist eine Konvertie-
rung nötig, um nach der Aufzeichnung einer Show den dazu gehörenden Ton hinzuzufügen. 
Außerdem kann man durch Konvertierung die Größe der Lpv Datei verkleinern, indem man die Qua-
lität, die Bildrate oder die Audio Qualität reduziert. 
Eine Konvertierung ist auch nötig, um Hintergrund-Bilder einzubetten. 
 

 
 
Source 

Name und Verzeichnis der zu konvertierenden Lpv Datei.  
Nach einer unmittelbar vorhergehenden Aufzeichnung befindet sich der Name der zuletzt aufge-
zeichneten Lpv Datei in diesem Feld. Zum Auswählen einer anderen Datei öffnen Sie die Dialogbox 
mit dem Button "Browse".  
 
Destination 

Name und Verzeichnis der Lpv Datei, die geschrieben werden soll.  
In dieses Feld müssen Sie eine Datei eintragen. Lassen Sie das Feld leer und drücken "Save" zur Aus-
führung der Konvertierung, werden Sie aufgefordert, eine Zieldatei anzugeben.  
Ist eine Lpv Datei in "Source" eingetragen, wird automatisch derselbe Name und dasselbe Verzeichnis 
in dieses Feld eingetragen. "Source" und "Destination" dürfen auch identisch sein, die aktuelle Datei 
wird dann mit der neuen Variante überschrieben.  
Möchten Sie diese ändern, öffnen Sie über den Button "Browse" die zugehörige Dialogbox.  
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Quality 

Wert der Bildqualität. (0 ... 100).  
Dieser Wert stellt die Bildkompression für die Lpv Datei ein. 90 führt zu einer guten Qualität. Nor-
malerweise sollten Sie es bei diesem Wert belassen. Kleinere Werte führen zwar zu kleineren Datei-
en, aber die Qualität nimmt auch sichtbar ab. Meist ist es besser, die Frequenz (Fps) zu limitieren, 
weil das subjektiv meist weniger stört als hier die Qualität zu verringern. 
 
Limit Fps 

Beim Aufzeichnen werden zunächst ohne Limitierung alle Bilder in die Lpv Datei übernommen. Das 
kann im Einzelfall dazu führen, dass 50 oder mehr Bilder pro Sekunde gespeichert werden. Im Nor-
malfall bringt das aber kaum einen Vorteil. Mit "Limit Fps" können Sie deshalb die Anzahl der Bilder 
begrenzen, die pro Sekunde gespeichert werden. Bei 20-25 werden Sie kaum einen Unterschied 
merken. Wenn Sie die Datei weiter verkleinern wollen, können Sie auch 10 oder 15 ausprobieren. 
Benutzen Sie diese Option nicht, wenn Sie später Interlaced AVI files erzeugen wollen oder wählen 
sie mindestens den doppelte Anzahl von Bildern pro Sekunde, z.B. 50 für interlaced PAL. 
 
Embed current display parameters 

Die eingestellten Preview-Parameter werden in der Lpv Datei abgespeichert. Wir empfehlen das 
normalerweise nicht. Besser ist es meist, schon vor der Aufzeichnung die "Super Preview" Parame-
ter im Lasergraph DSP richtig einzustellen. 
Falls Sie aber dennoch erreichen wollen, dass eine Show anders dargestellt wird, als sie ursprünglich 
aufgezeichnet wurde, können Sie die Parameter in Lpv Creator anpassen und die so veränderten 
Werte mit in die Lpv Datei abspeichern (einbetten). 
 
Update background bitmaps 

Abspeichern von Hintergrundbildern in der Lpv Datei. In den Preview-Parametern (siehe Kapitel 
"Properties - Background") können Sie bis zu vier Hintergrundbilder in eine Lpv Datei integrieren. 
Diese werden aber nur dann in die Lpv Datei übernommen, wenn Sie das hier explizit einschalten. 
 
Edit Audio 

Hinzufügen / Ersetzen der eingefügten Audiodatei.  
Aktivieren Sie diesen Parameter, wenn Sie eine vorhandene Audiodatei ersetzen möchten oder eine 
Audiodatei in eine Lpv Datei integrieren wollen.  
Ist dieser Parameter aktiviert, erhalten Sie Zugriff auf die folgenden Parameter.  
 
Replace 

Hinzufügen oder Ersetzen vorhandener Audiodateien.   
Besitzt eine Lpv Datei noch keinen Ton, aktivieren Sie diesen Parameter und klicken auf den Button 
"Browse" zur Auswahl einer Audiodatei. Unterstützte Audioformate sind WAV und OggVorbis.  
Deaktivieren Sie diesen Parameter, um nur die Audioeinstellungen des bereits in der Lpv Datei vor-
handenen Sounds zu verändern.  
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Resample 

Veränderung der Sample-Frequenz der Audiodatei. (1000 Hz ... 96000 Hz) 
Aktivieren und verändern Sie diesen Parameter, um die Audiodatei in einer von Ihnen gewählten 
Sample-Frequenz in die Lpv Datei zu integrieren.  
Die Sample-Frequenz gibt an, mit welcher Frequenz die Audiodaten abgetastet werden. Es gilt, je 
höher die Frequenz, desto besser die Qualität. Sie können hier z.B. eine mit 44100 Hz angelegte Da-
tei in der Größe verringern, indem Sie die Frequenz auf 22050 Hz reduzieren. Natürlich nimmt dann 
auch die Qualität ab. 
 
Mono 

Ist dieser Parameter aktiviert, wird die Audiodatei in Mono (Ein-Kanal-Ton) abgespeichert. Das spart 
Platz, wenn auch auf Kosten der Qualität. 
 
Quality 

Die Audio Qualität steuert das Verhalten der Kompression. Bei größeren Werten wird die Qualität 
besser, aber auch die Größe der Datei nimmt zu. 
Für eine gute Qualität wählen Sie 4, größere Werte bringen kaum noch Verbesserungen. Das ent-
spricht durchschnittlich 1 MByte pro Minute (bei 44100 Hz, Stereo). 
Wollen Sie die Datei auf Kosten der Qualität verringern, verkleinern Sie den Wert entsprechend. 
Dieser Wert ist eng mit bps verknüpft, denn eine bessere Qualität führt auch zu einer höheren Da-
tenrate und umgekehrt. 
 
bps 

Übertragungsraten in Bits pro Sekunde (bps).  Legt fest, wieviel Bits pro Sekunde für den Ton ver-
wendet werden sollen. Dieser Wert ist eng mit der Qualität verknüpft, denn eine höhere Datenrate 
führt zu einer besseren Qualität (und umgekehrt). 
 
Adjust Length of Lpv file by Audio 

Bei der Aufzeichnung werden Anfang und Ende der Lpv Datei anhand des ersten/letzten Bildes festge-
legt. Manchmal fängt aber der Ton schon vor dem ersten Bild an oder hört beim letzten Bild nicht 
gleich auf. Wenn Sie diese Option einschalten, wird der Ton analysiert und falls nötig werden Anfang 
und Ende erweitert. 
 
Protect 

Schützt Ihre Lpv Datei vor weiteren Veränderungen. Danach kann eine Lpv Datei in keiner Weise 
mehr verändert werden. Sie kann auch nicht mehr in das AVI Format gewandelt werden. Vorhandene 
Hintergrundbilder, z.B. Wasserzeichen oder Copyrights, können nicht entfernt werden. 
Beachten Sie, dass der Schutz nicht wieder entfernt werden kann. Auch nicht von Ihnen selbst! 
 
Hinweis:  
Um missbräuchliche Verwendung Ihrer Lpv Dateien zu verhindern, fügen Sie ein Logo oder Wasser-
zeichen in Ihrer Lpv Datei hinzu (siehe Kapitel "Lpv Creator Properties") und speichern Sie diese mit 
"Protect" ab.  
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Erstellen einer AVI-Datei 

Überblick 

Eine AVI-Datei beschreibt eine Multimedia-Datei, in der Audio- und Videodaten enthalten sind.  
Wird eine AVI-Datei mit hoher Qualität aufgezeichnet oder konvertiert, kann die Größe der Datei 
im Gegensatz zur Größe der Lpv-Dateien allerdings sehr groß werden. Trotzdem kann es sinnvoll 
sein, eine Lpv Datei in eine AVI Datei umzuwandeln, z.B. um sie in einem Video Programm weiter zu 
verarbeiten. 
 
Wollen Sie Ihre Lasershow später auf Video aufzeichnen (DV, MPEG oder ähnlich), sollten Sie die 
speziellen Seitenverhältnisse und Auflösungen beachten. Bildpunkte (Pixel) auf Computermonitoren 
sind normalerweise quadratisch. Für PAL oder NTSC Darstellungen gilt das nicht. 
Deshalb müssen spezielle Seitenverhältnisse beachtet werden, damit es nicht zu Verzerrungen 
kommt. Lpv Creator hat zwei Voreinstellungen, mit denen die Auflösung, Seitenverhältnisse usw. 
richtig für PAL (720x576, 25fps, 54:59) bzw. NTSC (720x480, 29.97fps, 11:10) eingestellt werden 
können. 
Die Darstellung am Computermonitor ist so zwar verzerrt, bei Darstellung in PAL/NTSC stimmt 
dann aber alles. Bereiten Sie alles so vor, dass die Darstellung am Computer korrekt ist. Drücken Sie 
dann Alt+F1 für PAL bzw. Alt+Umschalttaste+F1 für NTSC. 
 
Zum Öffnen des AVI Dialogs wählen Sie aus dem Menü File  Write AVI. Über den Dialog können 
Sie genau steuern, welcher Codec für die Kodierung der Video und Audio-Daten benutzt wird. 
Durch Klick auf den Button "Save" wird dann die AVI-Datei erstellt. 
Eine Fortschrittsanzeige informiert Sie über die geschätzte Dauer der Konvertierung. Sollten Sie 
"Play AVI when done" aktiviert haben, wird die AVI-Datei am Ende automatisch abgespielt. 
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Lpv 

Name der Lpv Datei, die in eine AVI-Datei gewandelt werden soll.  
 
Avi 

Name und Verzeichnis der zu erstellenden AVI-Datei. 
In diesem Feld befindet sich nach Auswahl der Lpv Datei der Name der AVI-Datei. Automatisch wird 
der gleiche Name und Pfad verwendet, unter Verwendung der Dateiendung für AVI-Dateien.  
 
Suppress Infos while creating AVI 

Beim Abspielen einer Lpv-Datei werden zusätzliche Informationen am Bildschirm eingeblendet, z.B. 
der Timecode. Normalerweise wollen Sie sicher nicht, dass die Informationen auch in die AVI Datei 
übernommen werden. Mit dieser Option kann die Anzeige dieser Informationen bei Erstellung der 
AVI Datei unterdrückt werden (Standardeinstellung). 
 
Fps 

Bildrate in Bildern je Sekunde (0.1 ... 120 frames per second).  
Stellen Sie hier die gewünschte Frequenz ein. Die europäische Fernsehnorm PAL ist auf 25 Bilder je 
Sekunde festgelegt, die amerikanischen Fernsehnorm NTSC benutzt 29,97 Bilder je Sekunde. 
Wenn Sie die Datei nur am Computer anzeigen wollen, können Sie meist frei entscheiden, welche 
Bildwiederholrate für Ihre Anwendung die richtige ist. 20 Hz reichen meist aus, um Bewegungen flüs-
sig erscheinen zu lassen. 
 
Interlaced 

Schalten Sie diese Option ein, um ein AVI für Wiedergabe auf einem Fernseher, Aufzeichnung auf DV 
oder spätere Wandlung für DVD Aufzeichnung (MPEG) zu erstellen. 
 
Upper fields first 

Bestimmt die zeitliche Reihenfolge der Halbbilder bei Erstellung von interlaced AVI Dateien. DV be-
nutzt immer "lower field first". 
 
Codec 

Hier wählen Sie den Codec aus, mit dem die Bilddaten in der AVI Datei komprimiert werden. Sie 
können auch "<Uncompressed DIB>" wählen, dadurch werden die Daten unkomprimiert gespei-
chert. Das ist evtl. sinnvoll, wenn Sie die Daten noch weiter verarbeiten wollen. Allerdings werden 
die Dateien dadurch sehr groß. 
Welche Video-Codecs Sie hier auswählen können, hängt von der Installation ihres Systems ab. Fast 
immer vorhanden ist der "Cinepak Codec". Dieser Codec führt zwar nicht zu der besten Qualität, 
aber AVI Dateien, die mit diesem Codec erzeugt wurden, können fast auf jedem Windows® System 
abgespielt werden. 
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Configure 

Öffnet die Dialogbox zur Konfiguration des eingestellten Codecs. Informationen hierzu finden Sie in 
der Dokumentation der Codecs. Nicht alle Codecs unterstützen diese Methode der Konfiguration. 
 
About 

Öffnet die Aboutbox des eingestellten Codecs (zeigt Informationen zu Hersteller und Version an). 
Nicht von allen Codecs unterstützt. 
 
Keyframe every "x" Frames 

Erzwingen von Keyframes. Ob das unterstützt wird, hängt vom Codec ab. Modernere Codecs redu-
zieren die Datenmenge dadurch, dass nur der Unterschied zum vorhergehenden Bild gespeichert 
wird (meist ändert sich nur ein Teil des Bildes). Keyframes kommen im Gegensatz dazu ohne Infor-
mationen über benachbarte Bilder aus. Das kostet zwar mehr Platz, aber ohne Keyframes könnte 
eine Datei nur von Anfang an abgespielt werden. Einspringen (z.B.) in die Mitte des gesamten Films ist 
dann nicht möglich. Deshalb empfiehlt es sich, wenigstens in gewissen Abständen Keyframes zu er-
zwingen. Z.B. entspricht ein Wert von 250 einem Keyframe alle 10 Sekunden (bei 25 fps). 
Wenn die Datei, z.B. in einem Schnittprogramm, weiterverarbeitet werden soll, macht es Sinn, hier 
noch kleinere Werte zu wählen, damit die Bilder schnell adressiert werden können. 
Ein Wert von 1 bedeutet, dass jedes Bild als Keyframe kodiert wird. Je nach Codec werden dadurch 
die Dateien wesentlich größer. 
 
Quality 

Qualität des Videos (0 ... 100). Diesen Wert können Sie in das Eingabefeld direkt eingeben oder über 
den Schieberegler darunter einstellen. Die genaue Bedeutung hängt vom Codec ab. Der Wert ist ein 
Maß für die Qualität, mit der die Bilder kodiert werden. 100 ist dabei die beste Qualität, 0 die 
schlechteste. Im Allgemeinen werden Dateien mit besserer Qualität größer. Welcher subjektiven 
Qualität der Wert 100 entspricht hängt vom Codec ab. Bei einigen Codecs entspricht der Wert 100 
der Qualität des Ausgangsmaterials, bei anderen ist selbst bei Qualität 100 schon eine deutliche Ver-
schlechterung wahrzunehmen. 
 
Datarate 

Einstellen einer festgelegten Datenrate in kBits/Sekunde.  
Zum Verändern der Datenrate aktivieren Sie bitte die Checkbox und geben Sie einen entsprechen-
den Wert ein. Nicht alle Codecs unterstützen die Begrenzung der Datenrate, und auch die genaue 
Bedeutung hängt vom Codec ab.  
 
Audio-Format 

Einstellen des Audio-Codecs. Genau wie für das Bild gibt es auch für den Ton viele verschiedene 
Kompressionsmethoden und Formate. Das PCM Format wird immer unterstützt. Dabei werden die 
Daten unkomprimiert gespeichert. Die weiteren Auswahlmöglichkeiten hängen wieder davon ab, 
welche Audio-Codecs auf Ihrem System installiert sind. 
Beachten Sie auch, dass einige Codecs angezeigt werden, aber nicht jedes Format unterstützen. Au-
ßerdem kommt es auch vor, dass Codecs zwar in der Liste erscheinen, aber trotzdem nicht zum 



Bedienungsanleitung Lpv Creator 2025/07/22 

 

 

LaserAnimation Sollinger GmbH    Crellestrasse. 19/20    D-10827 Berlin 
Phone  +49 (30) 780 963 00    Fax  +49 (30) 780 963 25 
Email  info@laseranimation.com    Internet  www.laseranimation.com 
 
Copyright © LaserAnimation Sollinger GmbH. All rights reserved. 

Seite 44 

Kodieren freigeschaltet sind. Es wird dann evtl. ein Fehler angezeigt, wenn Sie versuchen, die AVI-
Erstellung mit einem solchen Codec zu starten. Wählen Sie in diesem Fall ein anderes Format und 
versuchen Sie es erneut. 
Wenn Sie ganz sicher gehen wollen, dass Sie die AVI Datei auch abspielen können, sollten Sie beim 
PCM Format bleiben. Es gibt zwar effizientere Codecs, diese sind aber nicht auf allen Systemen ver-
fügbar. 
 
Variant 

Einstellen der Qualität, mit der ein Codec die Audiodaten komprimiert. Was genau Sie hier einstellen 
können, hängt vom eingestellten Format ab. Lpv Creator versucht eine Variante zu wählen, die dem 
Ausgangsmaterial in der Lpv Datei möglichst nahe kommt. Sie können aber die Dateigröße ggf. ver-
kleinern, indem Sie eine schlechtere Qualität akzeptieren. 
 
Status 

Anzeige der aktuellen Frames/Sekunde, der abgelaufenen Zeit und der verbleibenden Zeit während 
der Umwandlung in AVI-Dateien. 
Während der Erzeugung einer AVI-Datei wird der Status angezeigt. Durch Aktivieren der Checkbox 
"Details" werden alle Parametereinstellungen angezeigt, Änderungen der Parameter sind zu diesem 
Zeitpunkt aber nicht mehr möglich.  
 
Overwrite 

Automatisches Überschreiben einer bereits vorhandenen AVI-Datei. 
 
Play AVI when done 

Abspielen der AVI-Datei nach Fertigstellung. Zum Abspielen wird der Player verwendet, der auf Ih-
rem PC mit AVI Dateien verknüpft ist.  
 
Save 

Startet die Erzeugung der AVI-Datei. 
 



Bedienungsanleitung Lpv Creator 2025/07/22 

 

 

LaserAnimation Sollinger GmbH    Crellestrasse. 19/20    D-10827 Berlin 
Phone  +49 (30) 780 963 00    Fax  +49 (30) 780 963 25 
Email  info@laseranimation.com    Internet  www.laseranimation.com 
 
Copyright © LaserAnimation Sollinger GmbH. All rights reserved. 

Seite 45 

Danksagungen 

 
Vielen Dank an die Independent JPEG Group 

Diese Software basiert zum Teil auf der Arbeit der Independent JPEG Group. 
 
 
 
Vielen Dank an die Autoren von libpng, zlib 

Diese Software basiert zum Teil auf libpng and zlib. 
 
 
 
Vielen Dank an die Autoren von libogg and libvorbis 

Das Folgende ist der Copyright-Hinweis für libogg und libvorbis, die in dieser Software enthalten 
sind: 
 
Copyright (c) 2002, Xiph.Org Foundation 
 
Redistribution and use in source and binary forms, with or without modification, are permitted pro-
vided that the following conditions are met: 
 
• Redistributions of source code must retain the above copyright notice, this list of conditions and 

the following disclaimer. 
 
• Redistributions in binary form must reproduce the above copyright notice, this list of conditions 

and the following disclaimer in the documentation and/or other materials provided with the dis-
tribution. 

 
• Neither the name of the Xiph.Org Foundation nor the names of its contributors may be used to 

endorse or promote products derived from this software without specific prior written permis-
sion. 

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAM-
AGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABIL-
ITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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Release Notes 

 
Lpv Creator 2025/07/22 

Unterstützung von 24 DGCs pro Trickfilm. 
 
Neuer Menüpunkt zum Ändern der Fenstertransparenz. 
 
Die Bibliotheken von Drittanbietern wurden aktualisiert. 

 
 
 
Lpv Creator 2024/09/27 

Neuer Menüpunkt "Custom Resolution" zur Eingabe einer frei wählbaren Auflösung. 
 
Automatische und manuelle Software-Aktualisierungen. 
 
Die Bibliotheken von Drittanbietern wurden aktualisiert. 

 
 
 
Lpv Creator 2022/05/10 

Die maximale Anzahl an Kanälen, die für die Visualisierung verwendet werden kann, wurde von 8 
auf 16 vergrößert. 
 
Bugfix: Die Beam Detection erzeugte bei Verwendung der DisplayZone-Befehle fehlerhafte Linien. 
 
Innerhalb der Bibliotheken von Drittanbietern wurden Fehler behoben und Sicherheitslücken ge-
schlossen. 

 
 
 
Lpv Creator 2021/04/20 

Beim Multi Pass Recording können jetzt bis zu 32 Kanäle aufgezeichnet werden. 
 
Für "Sync to NetTimecode" wird jetzt keine Lizenz mehr benötigt. 
 
Verbesserte Kompatibilität mit Windows 10. 
 
Innerhalb der Bibliotheken von Drittanbietern wurden Fehler behoben und Sicherheitslücken ge-
schlossen. 
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Lpv Creator 2019/12/16 

Innerhalb der Bibliotheken von Drittanbietern wurden Fehler behoben und Sicherheitslücken ge-
schlossen. 

 
 
 
Lpv Creator 2016/04/22 

"Sync to NetTimecode" unterstützt jetzt auch Net Timecode mit 50fps und 60fps. 
 
Bugfix: Beim "Sync to NetTimecode" kam es bei 24fps und 30fps bei größeren Zeiten teilweise zu 
erheblichen Abweichungen. 
 
Innerhalb der Bibliotheken von Drittanbietern wurden Fehler behoben und Sicherheitslücken ge-
schlossen. 

 
 
 
Lpv Creator 2015/08/28 

In Verbindung mit den DisplayZone Befehlen konnte es zu Ausgabefehlern kommen. 
 
Bugfix: Unter bestimmten Bedingungen wurden die Daten für den Nebel bei jedem Programm-
start neu erzeugt. 
 
Innerhalb der Bibliotheken von Drittanbietern wurden Fehler behoben und Sicherheitslücken ge-
schlossen. 

 
 
 
Lpv Creator 2015/06/01 

Kleine Verbesserungen. 
 
 
 
Lpv Creator 2015/05/18 

Im Menü "View" wurde 1920x1080 als weitere vordefinierte Auflösung hinzugefügt. 
 
 
 
Lpv Creator 2015/02/27 

Unterstützung des neuen Parameters "Auto Maximize" im Super Preview Setup. 
 
Die Qualität der Visualisierung in "LightConverse" wurde verbessert. 
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Lpv Creator 2014/11/21 

Der Lpv Creator kann jetzt auch als Quelle für die Visualisierung in "wysiwyg" verwendet werden. 
 
Bugfix: Enthielt der Netzwerk-Name vom Lasergraph DSP Klammern, konnte zu diesem keine 
Verbindung aufgebaut werden. 

 
 
 
Lpv Creator 2014/04/08 

Kleine Verbesserungen, wie z.B.: 
 Neuer Menüpunkt "Play"  "Stop". 
 Neues Tastaturkürzel zum Beenden des Programms: <Strg+Q>. 

 
 
 
Lpv Creator 2014/03/21 

Neuer Installer löst Kompatibilitätsprobleme mit den 64-Bit Versionen von Windows®. 
 
Unter bestimmten Bedingungen konnte es vorkommen, dass sich der Visualization-Dialog nicht 
geöffnet hat. 

 
 
 
Lpv Creator 2013/12/10 

Der Lpv Creator kann jetzt als Quelle für die Visualisierung in "Realizzer 3D" verwendet werden. 
 
"Sync to NetTimecode" unterstützt jetzt auch Net Timecode mit 24fps, 30fps und 100fps. 
 
Bugfix: Die Wiedergabe von LPVs mit hochauflösenden Hintergrundbildern konnte unter be-
stimmten Bedingungen auf langsamen Computern zum Absturz führen. 
 
Unter CrossOver kam es in Verbindung mit dem "Mac Driver" zu Redraw Fehlern. 

 
 
 
Lpv Creator 2013/09/27 

Die Qualität der Visualisierung in "Depence V:3D" wurde verbessert. 
 
Im Menü "View" wurden weitere vordefinierte Auflösungen hinzugefügt. 
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Lpv Creator 2013/09/09 

Die maximale Anzahl an Kanälen, die für die Visualisierung verwendet werden kann, wurde von 4 
auf 8 vergrößert. Außerdem lassen sich Kanäle jetzt einzeln ausschalten. 
 
Unter Wine kam es innerhalb des Fensterrahmens zu Redraw Fehlern. 

 
 
 
Lpv Creator 2013/02/22 

Ein paar Probleme, die in Verbindung mit Wine aufgetreten sind, wurden behoben. 
 
Die Qualität der Visualisierung in "Capture Polar" wurde verbessert. 

 
 
 
Lpv Creator 2012/11/13 

Der Lpv Creator kann jetzt auch als Quelle für die Visualisierung in "Depence V:3D" und in  
"Capture Polar" verwendet werden. 
 
Mithilfe der neuen Funktion "Sync to NetTimecode" kann man die Wiedergabe von Lpv-Dateien 
zum empfangenen Net-Timecode synchronisieren. 
 
Die Visualisierung funktioniert jetzt auch, wenn der Lpv Creator minimiert ist. 

 
 
 
Lpv Creator 2012/07/13 

Der Lpv Creator kann jetzt als Quelle für die Visualisierung in "LightConverse" verwendet wer-
den. 
 
Mithilfe der neuen Funktion "Send NetTimecode" kann man den aktuellen Timecode als Net-
Timecode über das Netzwerk verschicken. 
 
Bugfix: Bei der Wiedergabe von sehr großen Lpv-Dateien funktionierte die Fortschrittsanzeige 
nicht richtig. 
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Anhang 

Tastaturkürzel für Menüs 

Funktion Menü Tastaturkürzel 
   
Öffnen File => Open Strg+O 
Schließen File => Close Strg+W 
Alle schließen File => Close All Strg+Entf 
Lasergraph DSP auswählen File => Select DSPs Strg+S 
Lpv aufzeichnen File => Record Lpv Alt+R 
Lpv konvertieren File => Convert Lpv Alt+C 
AVI erstellen File => Write AVI Alt+A 
Beenden File => Exit Strg+Q  /  Alt+F4 
   
Ausschneiden Edit => Cut Strg+X 
Kopieren Edit => Copy Strg+C 
Einfügen Edit => Paste Strg+V 
Eigenschaften Edit => Properties P 
Rücksetzen auf Datei-Standard Edit => Reset To File's Defaults  Strg+R 
Rücksetzen auf System-Standard Edit => Reset To Generic ... Strg+Alt+R 
   
Immer im Vordergrund View => Always On Top Strg+T 
Auflösung 720x576 (PAL)  Alt+F1 
Auflösung 720x480 (NTSC)  Alt+Umschalttaste+F1 
Auflösung 320x240 View => 320x240 F2 
Auflösung 640x480 View => 640x480 F3 
Auflösung 800x600 View => 800x600 F4 
Auflösung 1024x768 View => 1024x768 F5 
Auflösung 1280x800 View => 1280x800 F6 
Auflösung 1280x1024 View => 1280x1024 F7 
Auflösung 1440x900 View => 1440x900 F8 
Auflösung 1600x1200 View => 1600x1200 F9 
Auflösung 1920x1080 View => 1920x1080 F11 
Vollbilddarstellung View => Full Screen Alt+Return 
Kopfzeile / Rahmen View => Caption/Frame Strg+M 
Wiedergabesteuerung View => Playback Control E 
Informationen View => Infos I 
   
Wiedergabe / Pause Play => Play/Pause Leertaste 
Stumm schalten Play => Mute M 
Erste Datei  Strg+Bild ↑ 
Letzte Datei  Strg+Bild ↓ 
Nächste Datei Play => Next File Bild ↓ 
Vorhergehende Datei Play => Previous File Bild ↑ 
Anfang Play => Beginning Pos1 
Ende Play => End Ende 
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Vorspulen Play => Forward → 
Zurückspulen Play => Backward ← 
Schnelles Vorspulen Play => Fast Forward Strg+→ 
Schnelles Zurückspulen Play => Fast Backward Strg+← 
Nächstes Frame Play => Next Frame Strg+Alt+→ 
Vorhergehendes Frame Play => Previous Frame Strg+Alt+← 
   
Handbuch Help => Manual F1 
 
 
 
Tastaturkürzel für Eigenschaften 

 
Funktion Name des Parameters Tastaturkürzel 
   
Linienbreite + Line Width L 
Linienbreite - Line Width Umschalttaste+L 
Grafik + Graphics Intensity G 
Grafik - Graphics Intensity Umschalttaste+G 
Nebel + Fog Intensity F 
Nebel - Fog Intensity Umschalttaste+F 
 
 
 
Befehlszeilen-Parameter 

Der Lpv Creator kann mit folgenden Parametern von der Eingabeaufforderung oder von einer Ver-
knüpfung aus gestartet werden: 
 
 LpvCreator.exe [<options>] [<lpv-file> …] 
 
Mögliche Optionen: 
  

-f startet den Lpv Creator in Vollbilddarstellung 
-o spielt die angegebenen Lpv Dateien einmal ab und beendet danach das Programm 
-t öffnet das Programmfenster mit hoher Priorität (verdeckt andere Fenster)   

 

Lpv Datei: 
 

Es lassen sich eine oder mehrere Lpv Dateien angeben, die beim Programmstart automatisch 
 geöffnet werden. 
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